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Lawful
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Q.42 Select the most appropriate option to fill in the blank.

Dharambir Singh ran to break his previous record.

Ans x 1. fastly
« 2. faster
x 3. fast

x 4. fastest

Q.43 Select the most appropriate option that can substitute the underlined words in

the given sentence.

I am fearful of being in closed or confined spaces.

Ans x 1.acrophobic
% 2. xenophobic
x 3. agoraphobic

« 4. claustrophobic

Q.44 Select the most appropriate meaning of the given idiom.

Best thing since sliced bread
Ans 1. A goodideaor plan
¥ 2. A complicated problem with no solution
x 3. A mistake that leads to failure
x 4. Something that is outdated or old-fashioned

Q.45 Select the most appropriate option to fill in the blank.

___are going to the movies tonight.

Ans x 1.1t
x 2. Us
x 3. Yours

« 4. We
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Comprehension:

Read the given passage and answer the questions that follow.

If you think fairy castles exist only in dreams, Pamukkale will prove you wrong! It is a World
Heritage Site located near Denizli, in Turkey. Pamukkale, meaning ‘cotton castle’, is a
spectacular geological formation of natural white terraces with shallow basins and frozen
limestone waterfalls.

The waters of one of its may mineral-rich hot springs have been flowing down the terraces
for thousands of years, depositing calcium carbonate along the mountain-side to the
valley below. As the calcium crystallises, oyster-shaped pools and chalky-white stalactites
of limestone keep forming, making the entire place look like a snowy fortress from a
distance.

People have been bathing in the hot springs since Roman times, believing it to have
curative powers for various ailments like rheumatism. Pamukkale is also the site of the

ruins of an ancient city, Hierapolis, also a World Heritage site.
SubQuestion No : 46
Q.46 Select the most appropriate title for the given passage.
Ans x 1. A trip to Denizli
% 2. Diving into the Roman History
« 3. The wonders of Pamukkale

X 4. The magical hot springs
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Comprehension:

Read the given passage and answer the questions that follow.

If you think fairy castles exist only in dreams, Pamukkale will prove you wrong! It is a World
Heritage Site located near Denizli, in Turkey. Pamukkale, meaning ‘cotton castle’, is a
spectacular geological formation of natural white terraces with shallow basins and frozen
limestone waterfalls.

The waters of one of its may mineral-rich hot springs have been flowing down the terraces
for thousands of years, depositing calcium carbonate along the mountain-side to the
valley below. As the calcium crystallises, oyster-shaped pools and chalky-white stalactites
of limestone keep forming, making the entire place look like a snowy fortress from a
distance.

People have been bathing in the hot springs since Roman times, believing it to have
curative powers for various ailments like rheumatism. Pamukkale is also the site of the

ruins of an ancient city, Hierapolis, also a World Heritage site.

SubQuestion No : 47

Q.47 Which mineral is responsible for the formation of oyster-shaped pools in

Pamukkale?
Ans x 1. Magnesium
x 2. Sodium

x 3. Potassium

« 4. Calcium
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Comprehension:

Read the given passage and answer the questions that follow.

If you think fairy castles exist only in dreams, Pamukkale will prove you wrong! It is a World
Heritage Site located near Denizli, in Turkey. Pamukkale, meaning ‘cotton castle’, is a
spectacular geological formation of natural white terraces with shallow basins and frozen
limestone waterfalls.

The waters of one of its may mineral-rich hot springs have been flowing down the terraces
for thousands of years, depositing calcium carbonate along the mountain-side to the
valley below. As the calcium crystallises, oyster-shaped pools and chalky-white stalactites
of limestone keep forming, making the entire place look like a snowy fortress from a
distance.

People have been bathing in the hot springs since Roman times, believing it to have
curative powers for various ailments like rheumatism. Pamukkale is also the site of the

ruins of an ancient city, Hierapolis, also a World Heritage site.
SubQuestion No : 48
Q.48 Select the correct synonym of the word ‘curative’ as used in the passage.
Ans x 1. Transparent
% 2. Malleable
« 3. Therapeutic

x 4. Noxious
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Comprehension:

Read the given passage and answer the questions that follow.

If you think fairy castles exist only in dreams, Pamukkale will prove you wrong! It is a World
Heritage Site located near Denizli, in Turkey. Pamukkale, meaning ‘cotton castle’, is a
spectacular geological formation of natural white terraces with shallow basins and frozen
limestone waterfalls.

The waters of one of its may mineral-rich hot springs have been flowing down the terraces
for thousands of years, depositing calcium carbonate along the mountain-side to the
valley below. As the calcium crystallises, oyster-shaped pools and chalky-white stalactites
of limestone keep forming, making the entire place look like a snowy fortress from a
distance.

People have been bathing in the hot springs since Roman times, believing it to have
curative powers for various ailments like rheumatism. Pamukkale is also the site of the

ruins of an ancient city, Hierapolis, also a World Heritage site.

SubQuestion No : 49

Q.49 Select the most appropriate ANTONYM of the word ‘spectacular’ as used in the

passage.
Ans 1. Weary
X 2. Impressive

x 3. Stupendous

x 4. Combustible
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Comprehension:

Read the given passage and answer the questions that follow.

If you think fairy castles exist only in dreams, Pamukkale will prove you wrong! It is a World
Heritage Site located near Denizli, in Turkey. Pamukkale, meaning ‘cotton castle’, is a
spectacular geological formation of natural white terraces with shallow basins and frozen
limestone waterfalls.
The waters of one of its may mineral-rich hot springs have been flowing down the terraces
for thousands of years, depositing calcium carbonate along the mountain-side to the
valley below. As the calcium crystallises, oyster-shaped pools and chalky-white stalactites
of limestone keep forming, making the entire place look like a snowy fortress from a
distance.
People have been bathing in the hot springs since Roman times, believing it to have
curative powers for various ailments like rheumatism. Pamukkale is also the site of the
ruins of an ancient city, Hierapolis, also a World Heritage site.
SubQuestion No : 50

Q.50 Identify the tone of the passage.

Ans x 1. Nostalgic

% 2. Indignant
x 3. Tragic

« 4. Informative

Section : General Hindi and Comprehension
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Comprehension:

T 370 I7Eri: 291 & 3MMER UR fAgifeed ugl & 3R IfSre--

T Y ST IR & TAP G2 &b adlsl IR &P ¢ Ve ¢ 3R 31T 98 319 Horgd arelf &
HRATY & TS Bl SR ot WeweTdl ge 39 7 urdi T Y & Farfid & v &l ¢ i
A3, GH TG BT 1Td B YR BT 6 812 FAR H 97a BT Ueb I el 38T &1 Y1
ATl 3 U f&el 73 &1 TR P YA 390 F VAT g3 &, 39 &2 7 off U1 & & 3@l &1 73 1l &7 w@rrd
= BT 3 &, WG T 21 157 rar 1 578 e 72 &, I 371 W21 70T B & 3R 3uApht vl
DI 7R A 1T 971 Y, §GI-8G A8l I SIS | I8 S bl T § R ST, A1 RIGiddiT geb

A & HIATSTA H S i3 YR1A WSl bl 3&T b ol g1 ATGLTE-a1 BT T U G2 § HIdRd Bl
TMEd &, d I1G I 13 37 2 BIH I & & AH 7glF 31aef dliy & S| fFiee W &4 S,
o] 2T el 6 d 3G ATI3T BT HI 3G BT TGQM JATd, fbq eIV 6 qRIdaT 35

SGHY 39P U Hed hl ale &

SubQuestion No : 56
0.56 fUfafayd fasedl ¥ d S19A1 fAegwda I &1 faaiy g &2
Ans x 1. 3eAfdA®

x 2. AR D

« 3. 3
x 4. IBEITE!
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Comprehension:

f&U oTU 7eg: 91 & 3R WR FAgifed 94 & 3R dIfav--

T Y ST IR & TAP G2 &b adlsl IR &P ¢ Ve ¢ 3R 31T 98 319 Horgd arelf &
HRATY & TS Bl SR ot WeweTdl ge 39 i urdi T Y & Farfid & g4 &l ¢ i
A3, GH GG BT 1Td B YR BT 6 812 FAR H 7al BT Uep I el 38T &1 Y1
ATl 3 U f&el 73 &1 TR P YA 390 F VAT g3 &, 39 &2 7 off U1 & & 3@l &1 73 1l &7 w@rrd
= BT 3 &, WG T 21 517 urar 1 578 e 7 8, I 371 W27 7507 B & 37K 3uApft vl
DI 7R A 1T 971 Y, §GI-8G A8l I SIS | I8 S bl T § R ST, A1 RIGiddiT geb

A P HIATSTA H S i3 YR1A WSl bl &M b folv g ATGLTE-a1 &1 T U G2 § AIdRd Bl
TMEd &, d I1G I 13 37 2 BIH I & & AH 7glF 31aef dliy & S| fFiee W &4 S,
o] 2T el 6 d 3G ATI3T BT HI 3G BT TGQM JATd, fbq eIV 6 qRIdaT 35

QGBI 39P U Hed hl ale &

SubQuestion No : 57
Q.57 3URITH M & 3R 4R Fgferfad § I Si991 arw 3T 872

Ans x 1. RIgiddy gb dd I Hgld el &1 dlg & S|

« 2. T a1 BT WHTd T BIAT 34T Bio- B al
X 3. TR B AT ATl BT 3TH G317 &

X 4. A0 91dl DI WBRA H & gad g&d a4 qrea|
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Comprehension:

T 370 I7Eri: 291 & 3MMER UR fAgifeed ugl & 3R IfSre--

2 Y ST IR & TAP G2 &b adlsl R Gdd ¢ Vel ¢ 3R 31T 98 319 Horgd arelf &
HRATY & TS Bl SR ot WeweTdl ge 39 7 urdi T Y & Farfid & v &l ¢ i
A3, GH GG BT 1Td B YR BT 6 812 FAR H 7al BT Uep I el 38T &1 Y1
ATl 3 U feet 7 &1 TR P YA 390 F VAT g3 &, 39 &2 7 off U1 & & 3@0 &1 7 1l &1 @i
= BT 3 &, WG T 21 157 rar 1 578 e 72 &, I 371 W21 70T B & 3R 3uApht vl
DI 7R A 1T 971 Y, §GI-8G A8l I SIS | I8 S bl T § R ST, A1 RIGiddiT geb

A & HIATSTA H S i3 YR1A WSl bl &M b ol g9 ATGLTE-aT &1 T U4 G2 § AIdRd Bl
TIEd &, d I1G I 13 37 2 BIH I & &b A1H 7glF el @iy & 37| fFiee Weer &4 S,
o] 2T el 6 d 3G ATI3T BT HI 3G BT TGQM JATd, fbq eIV 6 qRIdaT 35

QGBI 39P U Hed hl ale &

SubQuestion No : 58

Q.58 e &F MR R 3R S|
I S| B cHBI 37P YTl A &I GIg &I |

Ans x 1. JddR
« 2. RIdcdar
x 3. TN frerd

x 4. efdgr e
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Comprehension:

T 370 I7Eri: 291 & 3MMER UR fAgifeed ugll & 3R IfSre--

2 Y ST IR & TAP G2 &b adlsl R Gdd ¢ Vel ¢ 3R 31T 98 319 Horgd arelf &
HRATY & TS Bl SR ot WeweTdl ge 39 7 urdi T Y & Farfid & v &l ¢ i
S, GH TG BT 1Td B YR BT 6 817 FAR H 97al BT Ueh I el 38T &1 Y1
ATl 3 U feet 7 &1 TR P YA 390 F VAT g3 &, 39 &2 7 off U1 & & 3@0 &1 7 1l &1 @i
= BT 3 &, WG T 21 157 rar 1 578 e 72 &, I 371 W21 70T B & 3R 3uApht vl
DI HIIR A &1 77 |, §&I-§& el IE SN | g e B 7d H AR 51397, 1 RigiddiT I

A & HIATSTA H S i3 YR1A WSl bl &M b ol g9 ATGLTE-aT &1 T U4 G2 § AIdRd Bl
TIEd &, d I1G I 13 37 2 BIH I & &b A1H 7glF el @iy & 37| fFiee Weer &4 S,
o] 2T el 6 d 3G ATI3T BT HI 3G BT TGQM JATd, fbq eIV 6 qRIdaT 35

QGBI 39P U Hed bl ale &

SubQuestion No : 59
0.59 fgfafyd fasedl ¥ A ST fApuRgid < &1 yAtIart =5 78l &2

Ans x 1.Hd

x 2.

v« 3. Rfg
X 4. &R0
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Comprehension:

f& oTQ Ter: 91 & 3R R FAgifed 9o & 3R difav--

2 Y ST IR & TAP G2 &b adlsl R Gdd ¢ Vel ¢ 3R 31T 98 319 Horgd arelf &
HRATY & TS Bl SR ot WeweTdl ge 39 I urdi Y & Farfid & 94 & ¢ i
S, GH TaGPT BT WPTA B YR BT A1Ed 817 THR § HIdl BT Ueb I Il @l &1 R
At B R et 91 &1 FAR & TeAep 90 § VAT g3 &, 397 <21 § off VA1 &1 81 1 81 73 el &7 @t
 BIAT A &, I3g G &1 57 A1al &1 57 et TRAT 8, IS 3BT 2019 U801 B &b 3R 3yAPh vt
DI HIIR A &1 77 |, §&I-§& el IE SN | g e B 7d H AR 51397, 1 RigiddiT I
dd P AT N S AT Q1 W] Bl 387 & fole 29 3aefgdr &1 o7 319 391 8 3raaiRd &l
TIEd &, d I1G I 13 37 2 BIH I & &b A1H 7glF el @iy & 37| fFiee Weer &4 S,
o] 2T el 6 d 3G ATI3T 1 HI 3G BT TGQM JATd, fbq 2oV 6 qRIdaT 32
SHHR 3P YT Heed & alg <l

SubQuestion No : 60
0.60 3URITD eI & 3R M &1 a9 B

Ans 1. 939G 3R AU 919
x 2. T yopfd
X 3.3 3R =1l

x 4. JgR® g+

0.61 Ms g3 H, fFgfafad & I S17-31 Te IRAUI, 449 §Y I 93 «id! § gga ¥ gad Hfoa
&?
Ans x 1.3 TellEs (Center-aligned)
¢ 2. 32-UaSs (Right-aligned)
X 3. % UeTigs (Left-aligned)
x 4. SNIETHIgs (Justified)
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Q.62 UHUY d% H, el Siagic Bl WA IWd g, Hi[al SiRgic $I U Hidl @I A¢ 417 AR
3Pl Blge Bifde # Ad $31 & fere, Fuferfad & I SI1-A1 fabey Il 872

Ans x1.Insert ¢§ 9R 31V, Save WR falds 3, AT AIH Slcl, BIg A BI2el Bife I, 3R Save I’
[ESEZCN]

¢ 2. File 29 IR 31T, Save As Jclae &, T ATH &Tct, DI A= BIsal BIAC I, 3R Save W fFid
B

x 3. Home 28 O3 311U, Save As UR fdaids &3, 9T ATH 3Td, 3TR Save W fdiss &3 |

X 4. File 29 R 31T, Save Jalde &, AT ATH 2cl, 3R BIS [d Bigdt BiFe |

0.63 {4315 ¥ BI9-AT ¢l BISAAX ST3ARN DI ST B3 3R YA S ¥ WIAdT BTl 872
Ans x 1.¢® AR (Task Manager)
x 2. BIOS
« 3. 5189 B93R (Device Manager)
x 4. B2 U4 (Control Panel)
0.64 A9-3MeTNd SO delise | sid Widd IHY, SHel dec &l oW & folv Ui fAgferfad & &
o fopan &1 3magadman ¢ il 82
Ans x 1. 3799 A BI132 B AT 8 BIAT
x 2. 319 SAdidT I SHc] &l IIq Bl
x 3. 30 & Jeolae @lsd WX facid B3l

4. 30cT Te I Ugct 3T¢THe SI3els vl

0.65 Fgfafad ¥ & $19-41, UAAraRA T Vb 39AHE &7
Ans x 1. B9 ®rsct (malicious files) fafie @Al
v 2. HIfeR JRIqd B3

x 3. B3 Jobd BT
X 4. TR W DY DT JR&f Bl
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0.66 fFHferf@d & d &I4-A1 HIAIS giidde, B B MS a2 Siagie A RS &I & 3R S
&1 ¥ auef §47a1 82

Ans x 1.Ctrl+P 3R Ctrl + C
@ 2. Ctrl + X 3fR Ctrl + C
x 3. Ctrl + X 3R Ctrl + P

x 4. Ctrl + Z 3R Ctrl + C

Q.67 A4 SI35R B If-HR B3 |, 3PTel BIA H SATaIfRpe ol FAuferf@d 7 A f6H fabey gRI

Sdd a1 31 b1 &, SRIA 6 I8 JATHd a1 511 I P SrarfEpe u? Rk dewrsd
T8 1 F B B I@ &2

Ans x 1. Settings A R 3V, Advanced Jciae &3, Network IR fadd &3, JavaScript IR 31T, 3R
T BT Allowed TR 21T B |

x 2. Tools B WX 311V, Options Aelde B3, Advanced UR fdeie B3, JavaScript TR 3V, 3R &4
&I Allowed TR i1t B |

« 3. Settings B R 37TC, Privacy and Security Icidc @3, Site Settings TR facid &Y,
JavaScript @R 3TV, 31k R4 BT Allowed UR T &3 |

X 4. File B 4R 371U, Preferences Jalde BV, Security TR faelds &Y, JavaScript IR 3¢, 3R Ra=
P Allowed TR 21Td B |

0.68 fHferf@d & § ®14-3 gcd Agad WA YA (Central Processing Unit - CPU) & AT
&?
Ans x 1. AReARS wifsid A (ALU) 3R AHRI A
x 2. HERY e 3R g99e/33eYe Ife
v 3. ARYARC S FifoI A (ALU) 3R SHelet IfHe (CU)
X 4. B JAC (CU) 3R TR JfAe

Q.69 UHUY Uravyige Usie9M (presentation) ¥ W89 3-9¢ 31 fecfie & fov eiidde T €2
Ans x 1.39¢ - Shift + M; f8efie - Ctrl G IW, Talae & 1R Delete AT

¢ 2.39¢ - Ctrl + M; f8efle - Ctrl gaTaR &, Jciae B3 3R Delete TV

x 3.39¢ - Ctrl + N; f&efie - Ctrl gaT®R 3%, Ielae B 3R Delete GaT¥

x 4.39¢ - Alt + M; f3efie - Ctrl GaTHR IQ, Jaide B3 3R Delete gaTv
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0.70 fHfaf@a ¥ 3 - 98 Rbice b &, i@l Befie 61 718 Bigd WA ¥y J Ryg &7
A ggal vATy 4SS 30T (MS Windows 0OS) o 3Rl ¥ & 11X &It &2

Ans x 1. f3clleg 3M8eRT (Deleted Items)
x 2.¢91 (Trash)
x 3. 9% §Ibe (Waste Basket)

¢ 4. AAH 8 (Recycle Bin)

Q.71 $YCR AR M9 7 F BI3-3 &fer1el ugdn Adban &2
Ans x 1. @S 312d H JUanal Seelld B3l

@ 2. TPIF BT SHIT BRAl
x 3. 9T P SBSY AT
x 4. BIscll B f3eiie Bl

Q.72 UHUY YiaRyige Naq g BI-AT 89, 3UAPTHdi3i & G5l &1 emde A1 Y 9ga 6l
Ifaem gaT= ST §?

Ans x 1. TR (Animations)
« 2. 3518 (Design)
x 3.8 (Home)

x 4. ¢if31eF (Transitions)

0.73 fHfaf&d & d S1-91, U ATHIY AISSR YI&T W (threat Hel &2
Ans x 1. TBfeRT (Phishing)

x 2. e SR (Social engineering )

x 3. AIIN (Malware)

4. FafAd JiTeadR 31932 (Regular software updates)

0.74 fgfefEad ¥ & 17 A1 ¢4 3MUS! AI3HINTR ds § Adldwe fHU U SRS & WHY[
(BIHTEM) BT dqei HI Ffaem ar &2
Ans x 1. File
x 2. Insert
« 3. Home

x 4. Review
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Q.75 UHUY 48 # UIF: eld ad-l diet Al H1 G AAEd B3 & felv Bed BTl f6d bR
§1d &2

Ans x 1.0A0Y g5 § HcH SRMAR §914 &1 Pis adidl 18l ol

« 2. Review > Spelling & Grammar > Custom Dictionaries U3 3TV

% 3. Insert > Reference > Custom Dictionaries U3 3TV

x 4. Tools > Options > Spelling and Grammar R 3TV

0.76 BIgd A # fAgfaf@d & & $19-9A1 fabed 3uATHaisi &I vtqey vrld § 92H dR U 8
abg® A9 B3 B Jfaem Tar &2

Ans 1. Save As

x 2. Print
x 3. Open

x 4. Save

Q.77 S0 Follge &l BIf-BR BId WY, SAB I Ael Yd? Bl A HI1 & falv B A ATFB
& MaIPHdr aidl &2

Ans x 1. IR 3R UrIas
x 2. UfpwM Hait
x 3. Ue3 BT EAd Ugd
@ 4. @R BeH 3R a1 AR

Q.78 3f& 37 v URId 2019 H, fbt Aq -1l b1 1S abg®b (unsaved workbook) &I &g
B3 BT YA B4 &, dl T aidT &2

Ans x 1.9%bq® f3efie & S 8
« 2. T I BT 1A & TSI gt i & fob R 319 3199 gRadAl bl Ad BT dIgd ¢l
x 3. 35g®H q¥d 9¢ & STl &
X 4. B It AwTC & ST 8l
Q.79 PIdl 3T &I BI-TT BITR TP A 3P IUAPTHAl3N &I ardfdsd Iud § U gididsl IR
AEIIT B Y Jfaer ar &2
Ans x 1.f9¢ Wi (Print preview)
x 2. 3T%arrgd A8 (Offline mode)
x 3. 9319 fgee? (Version history)

4. RIA-2e180 BIciaive (Real-time collaboration)
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0.80 PHUYCR & g &, af (worms) 3R 913 (viruses) AT &ld &2

Ans x 1. PR P gEIIR gTH
x 2. O U1 371 HRIeR PII-Gardl P! d¢Td &
v 3. O TR WITH S RIeR IR JHRATY 3qU- Hd &

X 4. YT TR G BT U JR& HBIR

Section : Quantitative Aptitude
Q.81 UTd T3 BT ATHd 655 &1 Ugell af A3 &1 30ud 75 & 3R ) F&=ar 101 81 Ay
&l Y13t &1 3d sird HIf3ru|

Ans x1.203
v 2.202
x3.176
x 4.177
0.82 AT & ferv @ Infigari M 3R K & o9 gu g1 #, 3ot def Adaransi & 9 56%
fastar 3ufigar M &1 Jad fbar, 5™ K @ 9,435 S die fiel| RPis & AR, 15%

dic 31de 91fd U e, 3R it gagrarst 3 34 die srell YA § oo Adardisi & d=n
fea- 42

Ans . 1.92,500
x 2.85,200
x 3.95,000
x 4.85,000

0.83 U%b &Pl ATHIAE 12 §2 H gH R STl &, Afp ¢H & del § RAT @7 S dRUI A WA A

4 ©¢ AP A P11 81 A& Zobl g o1 g3 @, dl RATd & H1Ror et Sl fpad 62 7
Frefl & refi?

Ans .24 ¢
x 2.36 8¢
x 3.48 €

x 4.12 82



https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap

Adda247

0.84 800 H ¥ fbd ufaerd &1 &l B3I 43 736 Yrd M2

Ans x1.12%
x2. 1%
v 3.8%

x 4.6%

Q.85 UISY A, B 3R C Us &P &b U 15, 30 3R 40 & ¥ MR Adbd &1 9ISy A, B 3R C & U
&l 147 PHLE Yag 7 J51, Yag 9 951 3R Y& 11 931 Wil AT g1 &P fPd I da R

SITeaI?
Ans x 1.3:40 p.m.
X 2.4:45 p.m.
¢ 3-4:20 p.m.
x 4.
3:20

p.m.

0.86 5006 P ATURYN (vulgar) = 7 yRafcfa Hifsel

x 1. 2001
500
x 2. 2003
500

v 3. 2503

500
4. 2506

500
0.87 U &al # 15 faenfial & 3iT &1 3id 48 21 3G YAS faandfi & 3id A B fqU AT,

d 71 3d sird Sifael

Ans x1.48

Ans

v 2. 96
x3.30

x 4.15

088 50+ VIBE + VT2 VI e e

Ans x 1. 14\;’2
X282
X3 9v2

v 4 1142
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0.89 G-t 3R 3W®T IRER At ¥ AT A 3Md &1 ATfaP FT Fe1 ¢ 6 RBR I & 3B
19 &1 91l 13 km/hr &, G¥G SALRT 4 km/hr $1 A1el I garfad &l @ 1 371 5l &
ydig & f&2m # 36 km 61 I a7 $I 3R B2 I RIS g U= a19¥ 31 9101  f6ad a9g
d® IS B34 &2 (Rpedn el )

Ans x1.68¢ 20 fAAe
x 2.5 ¢ 45 fiqe
» 3.68 07 fAAe
x 4.6 8¢ 05 e

0.90 & a¥ yga, IR 31R 37eMP $I 31 &1 31UTd 3 : 4 ATI & Y 916, 37hT Y BT AJUTd
4 : 5 G| 3T adHT HAY BT IPTHd STd HIfU|

Ans x1.2199
@ 2.23 T4
x 3.25dY
x 4.19 99

0.91 3ifPFd 319 &R A 3 km ¥ AT UId ddb $I gl 30 e § aF Hdr & 30 15 e T &R
d19 317dT1 &1 39 30 91 SiTd HIfsie|

Ans x 1.10 km/hr
« 2.8 km/hr
x 3.6 km/hr

x 4.12 km/hr

0.92 U el & a¥gV X 3R Y Ud® 34,000 ¥ WAl &1 dg 3799 I Ud® IR J°1H I
3ifpd BT &1 98 X B 78% 3R 64% $I 1 il G qH? 9491 ¢ 3R 6T ot 3158 &1
oty 3115 &a1 81 3fE 98 Y B 88% &Y Udbdl e WX o4 &, dl Y UR @y yfderd fa-n
&?

Ans 1 57.504
;(’2. 5704
X 3. 56%

K4 56.5%
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0.93 fHIl 93 &1 3ifPd Yo ISP HT I A 72% AP 81 I 9¥g IR $8 §C a1 & dIg oft
GPITGR Bl 29% b1 oM AT &Idl &, dl gHIIGR gIRT &l 715 ge qfererd sird Hifse|
Ans x1.28%

x2.23%
3. 25%

x 4.26%

0.94 Ifg U Afh 134 T 7 AR @S, IR A5 R &, di emw ufdad . % &l
Ans x1.235

x 2.225
o 3. 215

x 4.205

0.95 cfd®T b IdHI 1Y BT 4 AT, AATD b adHI- 31 F 3 [ A 18 a¥ 31AS &, a1 AATD

61 A1 31 BT 4 5T, AfdPST B AT 31 & 4 I A 12 99 &7 1 dfrst AR AAS
b1 qddar 31g &1 J17 (991 7) F1d Hifsiel

Ans x1.12
¢ 2.15
x 3.1

x4.13

0.96 fAgferfad &1 A1 siid HIf3Te:

35 -[25-{31-(22 - 11 + 8)}]
Ans x1.21

x2.19

3. 22

x 4. 25

Q.97 U Jid &I S-i@n ¥ af 2022 ¥ 0.8% $1 gfg i & 31 6= 9 2023 ¥ 0.75% &
dfg ardl &1 911d 61 siwn 7 sifaq ufaerd dfg drd Hifsiel

Ans  x1.1.566%
x 2.1.545%
x 3.1.565%

v 4. 1.556%
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Q.98 m &I dg "I JTd $If3e, 3it Fafef@d Tfieo Bl Aqe S

(11)14 ( g jS (11)3] ( g )9111+2

— | x|—=] x|—=] =|—

8 11 8 11

Ans 1 _8
9

;(2._2

0.99 U YT faebdl 175 H UP SRS avq @Il &1 3R 3URAT T25 81 98 3
gAaeiIe avq Bl T460 H a9l & 3R x% o9 AfSfd &1 &1 x BT 71 Srd HIfe|

Ans x1.150
x 2.110
« 3. 130

x 4.120

0.100 fA9MT 3 P HUTV 31 3ABT 40% N7 3R IRNdeT R Y fHAT a1 AY AFA FT1 25%
fedarel 93 Y BT 3R 11,970 §9d &A1, A P &1 AT SiTd HIfS0|

Ans x1.22,950
x 2.20,500
« 3.26,600

x 4.25,000
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